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• 请妥善保存文档，便于操作或使用设备时查看。
• 为了避免出现人员受伤或设备损坏危险，必须仔细阅读“基本安全指南”章节，以及针

对特定操作步骤的文档中的所有其他安全指南。
• 制造商保留修改技术参数的权利，恕不另行通知。Endress+Hauser 当地经销商将向您

提供最新文档信息和更新说明。
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修订历史
BA00395G/13.10
• 适用软件版本：18.0.0
• 初始版本
BA00395G/14.14
• 适用软件版本：18.0.2 和 18.0.3
• 对上一版本的修订：

新布局；改进产品、储罐和输转功能；为网格视图添加更多功能
BA00395G/15.16
• 适用软件版本：18.0.2 和 18.0.3
• 对上一版本的修订：

新特性
BA00395G/16.17
• 适用软件版本：18.1.1
• 对上一版本的修订：

统一 W&M 和非 W&M 应用软件包。
BA00395G/17.19
• 适用软件版本：18.2.5
• 对上一版本的修订：

添加可选软件组件“输转工单”。
BA00395G/18.24
• 适用软件版本：18.3.3
• 对上一版本的修订：

兼容 Windows 11 和 Windows Server 2022。对现有功能的影响极小。
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1  文档信息

1.1  文档功能
操作 Tankvision Professional NXA85 时应查阅本文档。
其中涉及输转系统的使用。
本文档为操作员使用软件提供辅助。
除计算机基本操作知识外，储罐计量系统操作无需专门培训。但还是建议用户参加
Endress+Hauser 的相关培训。

1.2  软件版本和认证
出于度量衡机构的认证程序原因，最新版本软件只能在日后进行认证。某些功能可
能不符合度量衡法规要求，因此无法组合使用。

1.3  信息图标

1.3.1  安全图标
!"

危险状况警示图标。若未能避免这种状况，会导致人员严重或致命伤害。
!"

潜在危险状况警示图标。若未能避免这种状况，可能导致人员严重或致命伤害。
!"

潜在危险状况警示图标。若未能避免这种状况，可能导致人员轻微或中等伤害。
!"

潜在财产损坏警示图标。若未能避免这种状况，可能导致产品损坏或附近的物品损坏。

1.3.2  特定信息图标和图中的图标
 提示

附加信息

参见文档

参考图

提示信息或重要分步操作
1. 、 2. 、 3.

操作步骤

操作结果
1、2、3 ...
部件号
A、B、C ...
视图
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1.4  文档资料
配套技术文档资料的查询方式如下：
• 设备浏览器（www.endress.com/deviceviewer）：输入铭牌上的序列号
• 在 Endress+Hauser Operations app 中：输入铭牌上的序列号或扫描铭牌上的二维

码。

1.5  注册商标

1.5.1  Windows®、Windows Server®
Windows 和 Windows Server 是微软公司的注册商标

1.5.2  关于商标的法律声明
所有公司/产品名称和/或所有公司徽标均为 Endress+Hauser 及其附属公司或各自所有者
的商标名、商标和/或注册商标。

https://www.endress.com/deviceviewer
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2  基本安全指南

2.1  人员要求
执行安装、调试、诊断和维护操作的人员必须符合下列要求：
‣ 经培训的合格专业人员必须具有执行特定功能和任务的资质。
‣ 经工厂厂方/操作员授权。
‣ 熟悉联邦/国家法规。
‣ 开始操作前，专业人员必须事先阅读并理解《操作手册》、补充文档和证书中(取决

于实际应用)的各项规定。
‣ 遵守操作指南和基本条件要求。
操作人员必须符合下列要求：
‣ 经工厂厂方/操作员针对任务要求的指导和授权。
‣ 遵守手册中的指南。

2.2  指定用途

2.2.1  Tankvision Professional NXA85 软件的指定用途
Tankvision Professional 专为散料储存设备、分销码头、炼油厂和输送管道运营方设
计。作为一种全集成解决方案，其提供完整的数据采集、监督控制和监测功能。
Tankvision Professional 将所有主要类型的罐区测量设备集成至同一系统中。
罐区和码头运营方以及连接的主站系统可以访问所有储罐参数测量值和计算值。
内置网页服务器支持多用户操作，允许在任何连接位置（本地/远程）访问数据，并用于
管理和计费目的。

2.3  IT 安全
我们提供的质保服务仅在根据《操作手册》安装和使用产品时有效。产品配备安全防护
机制，用于防止意外改动。
操作员必须根据相关安全标准执行 IT 安全措施，为产品和相关数据传输提供额外的防
护。
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3  到货验收和产品标识

3.1  到货验收
收到交货时：
1. 检查包装是否完好无损。

 立即向制造商报告损坏情况。
不要安装损坏的部件。

2. 用发货清单检查交货范围。
3. 比对铭牌参数与发货清单上的订购要求。
4. 检查技术文档资料及其他配套文档资料，例如证书，以确保资料完整。

如果不满足任一上述条件，请咨询制造商。

3.2  产品标识
软件标识信息如下：
• 铭牌参数
• 订货号，标识发货清单上的软件订购选项
• 在设备浏览器中输入铭牌上的序列号（www.endress.com/deviceviewer）：显示完整

软件信息。
在设备浏览器中输入铭牌上的序列号（www.endress.com/deviceviewer），显示配套技
术文档资料。

3.2.1  铭牌
铭牌上标识法律规定的相关产品信息，例如：
• 制造商名称
• 产品名称
• 订货号
• 扩展订货号
• 序列号
• 条形码

3.2.2  制造商地址
Endress+Hauser SE+Co. KG
Hauptstraße 1
79689 Maulburg, Germany
产地：参见铭牌。

3.2.3  订货号和产品版本号
登陆下列网址，在搜索区中输入铭牌上标识的订货号查询软件版本号：
www.products.endress.com/order-ident
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4  输转操作介绍
输转是罐区运营的核心。如果罐区是为储存散装液体而建，那么输转就是罐区运营的必
要组成部分，因为只有在产品能够进出设施的情况下，储存才能发挥作用。
输转系统是储罐计量系统中的一个模块，旨在协助安全管理产品在受监控场所内外和周
围的输转。它可以为操作员提供输转进度通知、安全操作程序的执行情况以及库存变化
报告。
本文档是《输转设置手册》的配套资料。其中介绍了完整输转系统的具体操作，并假定
读者首先看到的是经过正确设置的输转系统，输转中的许多关键功能都是可选的，并由
设置选项控制。建议负责罐区输转操作相关策略执行的人员仔细阅读这两本文档。

 1 主摘要屏幕

使用输转的主要界面为输转客户端，其主窗口如上图所示。系统中有 3 个输转视图，分
为三种操作状态：Planned、Open 和 Closed。单击黑色输转区域顶部的标签，选择需
要显示的输转。此窗口对于使用完整输转软件包至关重要，操作员应熟悉其操作。
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5  快速入门指南
本章节介绍如何针对一些常见场景制定输转计划。

这些场景并不一定适用于所有设置。

5.1  从船舶接收
1. 在主摘要屏幕上单击 Create new movement 按钮

 将显示新输转向导的第一页：

 2 第一页

2. 输入 Movement Name。如果未输入名称，则使用此输转的 ID 作为名称。输转的
Movement Name 显示在摘要屏幕的第 1 列中。

3. 选择 Product。此处仅供参考之用，可能会显示在摘要屏幕上。
4. 选择 Receipt 的 Movement Type。
5. 选择 Ship 的 Movement Class。
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6. 单击 Next 按钮。
 此时显示 Subject 页面：

 3 Subject 页面

7. 输入输转的 Subject 的名称。通常是船名。此名称将显示在摘要屏幕的 Subject 列
中。

就本例而言，假设船舶货物为 30 000 m3 的 DERV。一般而言，提供的是标准条件下的
货物体积和密度，在欧洲和美国，标准条件通常指标准大气压和 15 °C (60 °F)温度条
件。如果您的接收凭证中标注了货物重量（例如针对公路运输），请选择相应的目标类
型。

8. 输入 Planned Quantity，具体取决于 Target Type 的选择。
9. 输入参考密度，系统将利用它换算不同的物理量。

10. 单击 Next 按钮。
 将显示 Tank Movements 页面：

 4 Tank Movements 页面



Tankvision Professional NXA85 快速入门指南

Endress+Hauser 13

11. 首次打开页面时，将显示一行，显示系统中选择的第一个储罐。选择需要灌注的第
一个储罐，然后在 Movement Control 栏中选择 Fill。
 Planned Volume 将自动计算，并将变为灰色，表示无法修改。

如果储罐当前无有效液位（雷达液位计测量空罐，或者储罐还没有准备好接收货物
时经常会遇到这种情况），可以自定义液位和温度来进行计划。打开输转界面时，
将在该点获取当前液位，并检查所计划数量的有效性，以防止过度灌注储罐。

12. 单击 Add 创建第二个条目。选择需要灌注的第二个储罐的 Tank ID，然后在
Movement Control 列中选择 Fill。继续操作，直至为货物分配足够的容量。通
常，分配的货物不会注满选定的所有储罐，因此最后的储罐将设置为 No Control。

No Control 并不表示当您执行输转时，输转不会受到任何控制。在接收无法装入一
个储罐的大量货物时，通常的程序是将若干个储罐排成一排以便接收，当储罐装满
时，在从船中抽吸的同时更换储罐，直到将最后的剩余量注入最后一个储罐。当您
选择需要灌装的储罐时，目标液位将被确定为储罐的最大工作液位，而最后的 No
Control 储罐的目标液位则是通过估算产品液位来计算的，以适应最后的储罐打开
时的剩余输转容积。

通过单击每个储罐排左侧的 按钮从列表中删除一个储罐。

13. 单击 Next 按钮。如果显示 Timed Activities 页面，再次单击 Next 按钮。
 此时显示摘要页面。

14. 检查接收的详细信息是否正确，然后单击 Finish 按钮。
 输转计划现已完成。

5.2  加载到管道
1. 在摘要屏幕中，单击 Create new movement 按钮 。

 将显示新输转向导的第一页：

 5 加载到管道

2. 输入 Movement Name。如果未输入名称，则使用此输转的 ID 作为名称。输转的
Movement Name 显示在摘要屏幕的第 1 列中。

3. 选择 Product。此处仅供参考之用，可能会显示在摘要屏幕上。
4. 选择 Load 的 Movement Type。
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5. 选择 Pipeline 的 Movement Class。

Calculate ETF Based On 的设置决定了如何计算预计完成时间（ETF - Estimated
Time to Finish）。这些选项是在储罐计量系统通信层内计算出的几种不同流量。选
择哪个选项对输转运行方式的影响不大，至于是要反应缓慢的稳定流量，还是要反
应快速但可能不稳定的流量，实际上是个人选择。

6. 单击 Next 按钮。
 此时显示 Subject 页面：

 6 Subject 页面

7. 输入输转的 Subject 的名称。通常是管道名。此名称将显示在摘要屏幕的 Subject
列中。

8. 保持 Movement Control 字段为 Specified，保持 Target Type 字段为 Volume。

可以选择不同的体积和质量类型来定义输转量，选择哪种类型主要取决于所获得的
信息和仪器限制。如果需要忽略输转中游离水的影响，请选择 Total Observed
Volume。

9. 输入 Planned Quantity。
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10. 单击 Next 按钮。
 将显示 Tank Movements 页面：

 7 Tank Movements 页面

第一行将填入数据库中的第一个储罐。
11. 选择输转中第一个储罐的 Tank ID，并输入移出量。
12. 单击 Add，将更多储罐添加至输转操作。如果选择的储罐当前无有效液位，或者预

计在打开输转项时液位将不同，可以编辑起始液位（默认为当前储罐液位）。

如果预计在向管道排放过程中会对储罐进行再灌注，则可多次灌注同一储罐。

当第一个条目的详细信息被修改时，会自动创建第二个条目。

13. 选择输转中第二个储罐的 Tank ID，并输入移出量。继续操作，直至输转操作中的
所有储罐都已包括在内。

14. 检查储罐的 Total Volume 是否与管道的 Planned Volume 匹配（即 Discrepancy
为零）。

15. 单击 Next 按钮。如果显示 Timed Activities 页面，再次单击 Next 按钮。
 此时显示摘要页面。

16. 检查输转的详细信息是否正确，然后单击 Finish 按钮。
 输转计划现已完成。
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5.3  储罐间转移
1. 在摘要屏幕中，单击 Create transfer 按钮 。

 将显示简单储罐转移页面：

 8 简单储罐转移

2. 输入 Movement Name。如果未输入名称，则使用此输转的 ID 作为名称。输转的
Movement Name 显示在摘要屏幕的第 1 列中。

3. 为输转选择一个 Source Tank 和一个 Destination Tank。
4. 保持 Movement Control 为 Specified，保持 Movement Target Type 为 GSV。
5. 输入计划量。
6. 单击 OK 按钮。

 输转计划现已完成。

“简单储罐输转”屏幕仅限于创建两个储罐之间的一对一产品输转。输转系统能够管
理更复杂的输转操作，包括一对多或多对一输转，但都需要使用输转向导进行设
置。
“简单储罐输转”能够便捷地在多个场地创建多项“内务”输转操作。
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6  报警
除了 Tankvision Professional 生成的报警外，输转系统还能提供一些独特的报警。缺省
报警设置可以在缺省报警设置屏幕上配置（ 详情参见《输转设置手册》
BA00394G）。可以修改单个输转组件的报警设置（更多详情参见“储罐报警”和“定时任
务报警”章节）。

有关报警提示和确认的更多详情，请参见《系统操作手册》BA00396G 的相关章
节。

6.1  输转报警

6.1.1  净流量报警
如果输转类型为“储罐间转移”，可以启用净流量报警。如果输转过程中打开储罐的总净
流量超过预设定阈值，就会发出报警。默认情况下，报警的严重程度为高。
报警描述如下
movement：净输转流量大于 amount
其中，movement 为输转名称，amount 为预设定阈值。

6.2  储罐报警
当相应输转组件的状态为 Open 或 Reopened 时，输转中的储罐可能会发出以下报警。

6.2.1  目标报警时间
一次输转时每个储罐有两个目标报警时间（当输转类型为转移时包括对象储罐）。当输
转组件的 ETF 降至预设定阈值以下时，这些报警将被触发。默认情况下，首次报警的严
重程度为低，二次报警的严重程度为高。
两种报警的描述如下
  movement - tank ID：，将在 n 分钟内到达目标液位
其中，movement 为输转名称，tank ID 为储罐 ID，其正在接近完成时间，而 n 表示剩
余时间（单位为分钟）。

6.2.2  接近目标液位报警
一次输转时每个储罐有两个接近目标液位报警（当输转类型为转移时包括对象储罐）。
当储罐中的产品液位达到储罐目标液位的预定义距离时，这些报警将被触发。默认情况
下，首次报警的严重程度为低，二次报警的严重程度为高。
两种报警的描述如下
  movement - tank ID：产品液位达到目标液位的 distance 内
其中，movement 为输转名称，tank ID 为储罐 ID，其正在接近目标液位，而 distance
表示与目标液位之间的距离。

6.2.3  已达到目标液位报警
在输转时，达到储罐目标液位时，将触发已达到目标液位报警（如果输转类型为转移时
包括对象储罐）默认情况下，报警的严重程度为高。
报警描述如下
  movement - tank ID：到达目标液位
其中，movement 为输转名称，tank ID 为已达到目标液位的储罐 ID。
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6.2.4  已超过目标液位报警
超出储罐目标液位的量大于预定义距离时，将触发已超过目标液位报警。默认情况下，
报警的严重程度为严重。
报警描述如下
  movement - tank ID：超过目标液位
其中，movement 为输转名称，tank ID 为已超过目标液位的储罐 ID。

6.2.5  低流量报警
当储罐中的流量低于预设定阈值时，触发低流量报警。默认情况下，报警的严重程度为
高。
报警描述如下
  movement - tank ID：流量低于 amount
其中，movement 为输转名称，tank ID 为低流量的储罐 ID，而 amount 为预设定阈值。

6.2.6  反向流量报警
当储罐中的流向与预期输转方向相反时，反向流量报警触发。默认情况下，报警的严重
程度为高。
报警描述如下
  movement - tank ID：流向与预期方向不符
其中，movement 为输转名称，tank ID 为流向不正确的储罐 ID。

6.3  定时任务报警
当相应输转组件的状态为打开或 Reopened 时，可能因输转中的定时任务发出以下报
警。

6.3.1  完成时间报警
在一次输转中，每个定时任务有两个完成时间报警。当任务的剩余时间低于预设定阈值
时，这些报警将被触发。默认情况下，首次报警的严重程度为低，二次报警的严重程度
为高。
两种报警的描述如下
  movement - tank ID (activity)：任务将在 n 分钟后完成。
其中，movement 为输转名称，tank ID 为储罐 ID，activity 为任务描述，而 n 表示剩余
时间（单位为分钟）。

6.3.2  任务完成报警
定时任务打开的时长与此任务的计划时间匹配时，触发任务完成报警。默认情况下，报
警的严重程度为高。
报警描述如下
  movement - tank ID (activity)：任务完成
其中，movement 为输转名称，tank ID 为储罐 ID，而 activity 为任务描述。

6.3.3  任务过期报警
定时任务打开的时长超出计划时间的量大于预定量时，将触发任务过期报警。默认情况
下，报警的严重程度为严重。
报警描述如下
  movement - tank ID (activity)：，任务在 n 分钟之前完成
其中，movement 为输转名称，tank ID 为储罐 ID，activity 为任务描述，而 n 表示超过
完成时间的时间（单位为分钟）。
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7  摘要屏幕
输转摘要屏幕可以通过以下方式从 Tankvision Professional 主页访问：
• 从 View 菜单中选择 Movements 条目。
• 单击快捷方式栏上的 Movements 按钮 。
• 从输转工具栏上的 Movements 菜单中选择 Movements 条目。
输转摘要屏幕显示所有计划及打开的输转的详细信息。另外，还显示过去 24 小时内关
闭的输转。摘要屏幕从显示的计划输转开始（参见“主摘要屏幕”）。
查看打开和关闭的输转
打开的输转可以单击 Open 选项卡查看。与之类似，过去 24 小时内关闭的输转可以单
击 Closed 选项卡查看。
调整文本大小
摘要屏幕上的文本大小可以通过单击工具栏上的放大文本按钮 ，或从菜单中选择
View → Text Size → Make Larger 进行放大。类似地，也可以单击工具栏上的缩小文本
按钮 ，或从菜单上选择 View → Text Size → Make Smaller 进行缩小。
调整列宽
在两个标题栏之间的分界线上按住鼠标左键，然后向左或向右拖动，即可更改摘要屏幕
中各栏的宽度。
输转组件
还可以修改每个视图（Planned/Open/Closed）上显示的输转详情。

详细信息参见《输转设置手册》BA00394G。

用鼠标单击即可选择输转组件。如果需要选择多个组件，应按住 Ctrl 键，同时单击
需要选择的其他组件。

7.1  工具栏图标
创建转移（参见“简单储罐转移”）

创建新输转（参见“新输转向导”）

打开/重新打开输转（参见“打开输转”）

暂停输转（参见“暂停输转”）

关闭输转（参见“关闭输转”）

取消输转（参见“取消输转”）

输转日志（参见“输转日志”）

输转历史记录（参见“输转历史记录”）

输转证书（参见“输转证书”）

历史输转（参见“历史输转”）
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放大文本

缩小文本
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8  输转生命周期

8.1  计划输转
可以使用“新输转”向导或“简单储罐转移”屏幕创建新输转。

8.1.1  新输转向导
单击工具栏上的 Create new movement 按钮 或从 Movements 菜单上选择 New，运
行新输转向导。

输转详情页面
新输转向导中的第一页为 Movement Details 页面：

 9 Movement Details 页面

此页面包含以下字段：
Movement Name
用于识别输转的名称。如果未输入名称，此处将设置为输转 ID。
Product
与输转相关的产品。此处仅供参考之用，可能与接收或装载储罐中的产品不一致。其默
认为在输转系统设置屏幕中选择的产品（ 更多详情参见《输转设置手册》
BA00394G）。

在产品名称和产品 ID 之间切换 Product。
Movement Type
输转的类型。必须是可从下拉列表中选择的四种预定义类型之一。
Movement Class
输转的类别。此下拉列表仅包含与所选 Movement Type 相关联的输转类别（ 更多详
情参见《输转设置手册》BA00394G）。
Calculate ETF Based On
此字段允许选择体积流量类型（用于计算输转打开时的输转 ETF）。
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Custom Data Fields
Calculate ETF Based On 字段下方最多有五个自定义数据字段。这取决于所选
Movement Class（ 更多详情参见《输转设置手册》BA00394G）。

对象页面
Subject 页面用于输入输转对象的详情。对于 Receipt 或 one-to-many Transfer，对象为
源储罐。对于 Load 或 many-to-one Transfer，对象为目标储罐。

 10 Subject 页面

此页面包含以下字段：
Subject
此字段仅显示 Load 和 Receipt 输转类型。其用于输入输转对象的相关信息，例如船名
或货车牌照。
Source/Destination Tank ID
显示此字段，以取代“转移”输转类型的 Subject 字段。从系统中所有储罐的下拉列表中
选择源储罐或目标储罐。
Movement Control
确定输转对象的计划数量。

Receipt Load Transfer
(one to many)

Transfer
(many to one)

Fill     Planned Quantity 为将对象（目标）储罐灌
注至最高工作液位所需的数量。

Empty     Planned Quantity 为（源）储罐中的可用容
积。（即以最小工作液位为目标）。

Strip     目标是使源储罐的总计量容积为 0。注意
TOV 的默示用法为 Target ype。

No Control     Planned Quantity 取决于向导的储罐页面上
设置的数量。

Specified     必须输入对象的 Planned Quantity。

Target Type
此字段只有在指定对象的计划数量时才可见。下拉列表允许选择是否将计划数量输入为
GOV、TOV、GSV、Weight 或 Mass。如果 Movement Type 是转移选项之一，则可以
将数量指定为绝对数量或液位。
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Planned Volume/Planned Weight/Stop Gauge By
此字段只有在指定对象的计划数量时才可见。用于输入对象的计划数量。
Reference Density
此字段仅对于接收可见。其允许输入接收产品的参考密度。其他类型的输转在计算时使
用源储罐的密度。

储罐页面
储罐页面用于输入需要输转的储罐的详情。

 11 储罐页面

Target Type 字段用于指明计划数量是以体积、重量还是液位形式输入。选项包括体积
和重量的多种变体以及绝对形式。例如，“绝对 GOV”允许将储罐装满，直至储罐中的产
品数量足以满足输入的绝对体积。页面底部的总计值将显示为体积，除非选择了按重量
计量的可调整量规，此时将显示为重量。
Total Volume/Weight 字段显示所有选定储罐的计划总量。
Planned Volume/Weight 字段显示所有输转对象的计划总量。
Discrepancy 字段表示所选储罐的计划总量与输转对象的计划总量之间的差值。如果此
值为正数，则表示对象的计划体积大于储罐的计划体积。如果此值为负数，则表示储罐
的计划体积大于对象的计划体积。
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在输转中添加储罐
‣ 如需在输转中添加储罐，单击 Add 按钮。

 输转中将增加一个新储罐：

 12 添加储罐

默认情况下，Tank ID 将设置为列表中首个储罐的储罐 ID，Movement Control
将设置为 Specified，并且 Planned Quantity 设置为 0。Start Level 和
Temperature 的默认值为当前储罐液位和温度；这些数值可以被覆盖，以便在开
始输转前进行计划。

通过下拉列表中的 Tank ID 选择储罐。然后，可以指定储罐的输转控制：

Receipt Load Transfer
(one to many)

Transfer
(many to one)

Fill     Planned Quantity 是将储罐灌注至最高工作
液位所需的数量。

Empty     Planned Quantity 是将储罐排空至最小工作
液位所需的数量。

Strip 1)     将采用储罐的整个当前 TOV，这表示目标液
位低于最低工作液位以及罐底的任何水或沉
淀物。

No Control     Planned Quantity 取决于对象的计划数量。
Specified     必须输入 Planned Quantity。

1) 当目标类型为 TOV 或 Absolute TOV 时，作为输转控制选项显示。

如果已选择 Fill、Empty、Strip 或 No Control 的输转控制，计划数量由计算得出，不
能输入。如果已为对象输转类型选择了 No Control，则不可用于储罐。

请注意，如果选择了 No Control，则将灌注接收储罐，直至使用完所有计划的对象
数量，或者达到最高工作液位。类似地，对于装载储罐，它将被清空，直至所有计
划的对象数量都被计算在内，或者达到最低工作液位。如果为多个储罐选择 No
Control，它们将被灌注/排空，直至对象的所有计划数量都被计算在内。

在输转中删除储罐
‣ 如需删除储罐，单击待删除行左侧的 Delete 按钮 。
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定时任务页面
只有在输转系统设置中勾选 Include timed activities page 并且至少设置了一个定时任
务时，才会显示此页面。

 13 Timed Activities 页面

此页面的工作方式与储罐页面相似。始终存在一个虚拟任务，Tank ID 列表中选择第一
个储罐，Activity 列表中选择第一个任务，且 Planned Time 中选择 0:00。

添加任务
‣ 如需添加任务，选择任务的 Tank ID，选择 Activity 并输入 Planned Time。

 将自动创建一个新虚拟行。

删除任务
‣ 如需删除任务，单击待删除行左侧的 Delete 按钮 。

摘要页面
向导的最终页面为 Summary 页面，便于用户确认输入的信息：
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 14 Summary 页面

‣ 如需创建输转，单击 Finish 按钮。
 然后，新输转将出现在摘要屏幕的计划输转列表中，并在审计跟踪中创建一个新

条目，用于详细说明新输转。

8.1.2  简单储罐转移
简单储罐转移屏幕可通过单击工具栏上的 Create transfer 按钮 启动。

 15 简单转移屏幕

此屏幕包含以下字段：
Movement Name
用于识别输转的名称。如果未输入名称，此处将设置为 Movement ID。
Source Tank
需要使用的储罐的 Tank ID 作为输转的源储罐。
Destination Tank
需要使用的储罐的 Tank ID 作为输转的目标储罐。
Movement Control
确定如何计算输转的计划数量：

Movement Control Source Tank Destination Tank
Empty Empty No Control
Strip Empty + Dead stock + Free water TOV



Tankvision Professional NXA85 输转生命周期

Endress+Hauser 27

Movement Control Source Tank Destination Tank
Fill No Control Fill
Specified Specified Specified

更多详情参见“附录：转移量计算”。
Stop Gauge By
如果输转控制设置为“指定”，则确定如何输入计划数量。
Planned Volume/Weight
源储罐和目标储罐的计划数量。

‣ 单击 OK 按钮创建新输转。
 将创建输转类型“Transfer (one to many)”。新输转将出现在摘要屏幕的计划输

转列表中，并在审计跟踪中创建一个新条目，用于详细说明新输转。

8.2  修改计划数据
允许修改输转组件的计划数据，直至输转组件关闭。可以从摘要屏幕或从输转的详情屏
幕进行修改。

1. 在摘要屏幕或输转详情屏幕上选择要修改的输转组件，然后从 Movements 菜单中
选择 Amend Planned Figures 项目。或者，用鼠标右键单击输转组件，然后从显
示的菜单中选择 Amend Planned Figures。
 将显示一个屏幕，允许输入修改后的数据：

 16 修改计划数据

2. 单击 OK 保存计划数据的更改。单击 Cancel 关闭屏幕且不保存更改。
 保存更改后，审计跟踪中会创建一个新条目，显示更改情况。

8.3  添加储罐
储罐可以添加到输转中，直至输转完成（即所有输转组件都已关闭或取消）。可以从摘
要屏幕或从输转的详情屏幕进行添加。
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1. 在摘要屏幕或输转详情屏幕上选择属于要添加储罐的输转的组件，然后从
Movements 菜单中选择 Add → Tank。或者，用鼠标右键单击组件，然后从显示
的菜单中选择 Add → Tank。
 将显示一个页面，以便将储罐的详细信息输入到输转中：

 17 添加储罐

显示已在输转中的储罐的详细情况，以及与对象的计划体积的差异。

输入储罐详情的方法与创建新输转的方法相同。

2. 单击 OK 添加新储罐至输转，或单击 Cancel 关闭屏幕而不添加储罐。
 当在输转中添加了一个新储罐时，就会在审计跟踪中写入一个新条目，说明新

储罐的详细情况。

8.4  添加定时任务
定时任务可以添加到输转中，直至输转完成（即所有输转组件都已关闭或取消）。可以
从摘要屏幕或从输转的详情屏幕进行添加。

1. 在摘要屏幕或输转详情屏幕上选择属于要添加定时任务的输转的组件，然后从
Movements 菜单中选择 Add → Timed Activity。或者，用鼠标右键单击组件，然
后从显示的菜单中选择 Add → Timed Activity。
 将显示一个页面，以便将定时任务的详细信息输入到输转中：

 18 添加定时任务

此屏幕包含输转中已有的定时任务的详细信息，并允许输入新定时任务的详细
信息。
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2. 单击 OK 添加新定时任务至输转，或单击 Cancel 关闭屏幕而不添加定时任务。
 当输转中添加了一个新定时任务时，就会在审计跟踪中写入一个新条目，说明

新定时任务的详细情况。

8.5  编辑报警设置
为每个输转和输转上的每个组件创建一组默认报警。在摘要屏幕或输转详情屏幕中选择
单个组件，然后在 Movements 菜单中选择 Edit Alarm Configuration，即可修改组件
的报警设置。或者，用鼠标右键单击输转组件，然后从显示的菜单中选择 Edit Alarm
Configuration。

8.5.1  储罐报警设置

 19 储罐报警设置

‣ 单击 OK 保存报警设置的更改，或单击 Cancel 关闭屏幕且不保存更改。
 当报警设置更改时，在审计跟踪中写入一个新条目，其中包含更改的详细信息。

8.5.2  定时任务报警设置

 20 定时任务报警设置

‣ 单击 OK 保存报警设置的更改，或单击 Cancel 关闭屏幕且不保存更改。
 当报警设置更改时，在审计跟踪中写入一个新条目，其中包含更改的详细信息。
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8.6  打开输转
可以从摘要屏幕或从输转的详情屏幕打开输转组件。

‣ 在摘要屏幕或输转详情屏幕上，选择要打开的输转组件，然后单击工具栏上的
Open/Reopen movement 按钮 或从 Movements 菜单上选择 Open/Reopen 条
目。

这些选项只有在所有选定的输转组件都属于同一输转且状态为 Planned 或
Suspended 时才可用。

或者，用鼠标右键单击输转组件，然后从显示的菜单中选择 Open/Reopen。

8.6.1  储罐输转
如果有任何输转组件被产品状态和/或储罐状态阻止，则会显示以下覆盖框：

 21 覆盖框
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‣ 勾选所需储罐，然后单击 OK 覆盖阻止并打开输转，或者单击 Cancel 放弃输转。
 如果在输转系统设置中已勾选相关的输入手动数据选项，将显示此屏幕，以便更

新储罐的手动数据：

 22 修改手动数据

同样，如果在输转系统设置中已勾选相关修改数量选项，将显示此屏幕，以便在
输转打开前修改计划数量：

 23 修改计划数据

如果在输转系统设置中已勾选两个相关选项，将显示此屏幕，以便修改手动数据
和计划数量：

 24 修改手动数据和计划数据

如果计划数量将会使储罐内含物超出最高或最低工作液位，则会显示以下屏幕。
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 25 目标警告

对计划数量进行编辑以纠正问题之前，导致超出储罐容积或储罐内剩余容积降至零
以下的输转组件将无法打开。
导致超出最高或最低工作液位的输转组件可以打开（取决于当前用户的访问权
限），但也会在审计跟踪中写入一条记录。
当输转组件打开时，它们将在摘要屏幕上从 Planned 移动至 Open 视图。任何更改
详情都将写入审计跟踪。此外，还将在审计跟踪中添加一个条目，表明此输转已被
打开。

8.6.2  定时任务
如果在输转系统设置中已勾选相关修改计划时间选项，将显示此屏幕，以便在定时任务
打开前更新计划时间：

 26 修改计划时间

当定时任务打开时，将在摘要屏幕上从 Planned 移动至 Open 视图。任何更改详情都将
写入审计跟踪。此外，还将在审计跟踪中添加一个条目，表明此定时任务已被打开。
主页上的定时任务图标将从 Planned 变更为 Open 。

8.7  暂停输转
可以从摘要屏幕或从输转的详情屏幕打开输转组件。

‣ 在摘要屏幕或输转详情屏幕上，选择要暂停的输转组件，然后单击工具栏上的
Suspend movement 按钮 或从 Movements 菜单上选择 Suspend 条目。

这些选项只有在所有选定的输转组件都属于同一输转且状态为 Open 或 Reopened
时才可用。

或者，用鼠标右键单击输转组件，然后从显示的菜单中选择 Suspend。

8.7.1  储罐输转
如果在输转系统设置中已勾选相关的输入手动数据选项，将显示此屏幕，以便更新储罐
的手动数据：
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 27 更新手动数据

当输转组件暂停时，将在摘要屏幕上从 Open 移动至 Planned 视图。

请注意，重新打开暂停的输转组件会导致其“拆分”。将关闭原始输转组件，并为剩
余计划数量创建和打开一个新输转组件。
任何更改详情都将写入审计跟踪。此外，还将在审计跟踪中添加一个条目，表明此
输转已被暂停。

8.7.2  定时任务
当定时任务组件暂停时，将在摘要屏幕上从 Open 移动至 Planned 视图。
主页上的定时任务图标将从 Open 变更为 Suspended 。

请注意，重新打开暂停的定时任务组件会导致其“拆分”。将关闭原始定时任务组
件，并为剩余计划数量创建和打开一个新定时任务组件。
任何更改详情都将写入审计跟踪。此外，还将在审计跟踪中添加一个条目，表明此
输转已被暂停。

8.8  关闭输转
可以从摘要屏幕或从输转的详情屏幕打开输转组件。

‣ 在摘要屏幕或输转详情屏幕上，选择要暂停的输转组件，然后单击工具栏上的 Close
movement 按钮 或从 Movements 菜单上选择 Close 条目。

这些选项只有在所有选定的输转组件都属于同一输转且状态为 Open 或 Reopened
时才可用。或者，用鼠标右键单击输转组件，然后从显示的菜单中选择 Close。
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8.8.1  储罐输转
如果在输转系统设置中已勾选相关的输入手动数据选项，将显示此屏幕，以便更新储罐
的手动数据：

 28 更新手动数据

当输转组件关闭时，将在摘要屏幕上从 Open 移动至 Closed 视图。

任何更改详情都将写入审计跟踪。此外，还将在审计跟踪中添加一个条目，表明此
输转已被关闭。

8.8.2  定时任务
当定时任务组件关闭时，将在摘要屏幕上从 Open 移动至 Closed 视图。还将在审计跟踪
中添加一个条目，表明此定时任务已被关闭。
如果没有为储罐计划更多定时任务，则 Timed Activity 图标将从主页中删除，否则将更
改为 Planned 。

8.9  取消输转
可以从摘要屏幕或从输转的详情屏幕取消输转组件。

‣ 在摘要屏幕或输转详情屏幕上，选择要暂停的输转组件，然后单击工具栏上的
Cancel movement 按钮 或从 Movements 菜单上选择 Cancel 条目。

这些选项只有在所有选定的输转组件都属于同一输转且状态为 Planned 时才可用。

或者，用鼠标右键单击输转组件，然后从显示的菜单中选择 Cancel。
如果储罐没有其它定时任务组件，Planned 图标（ ）将从主页删除，否则将显示最高
优先级图标（ 、 、 ）。
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9  输转详情屏幕
输转详情屏幕可以从摘要屏幕或 Tankvision Professional 主页进行访问：

‣ 在摘要屏幕上选择一个或多个输转组件（属于需要显示的输转），然后从
Movements 菜单中选择 Show Details。或者双击输转组件以显示其所属输转的详细
信息，或者用鼠标右键单击此组件并从显示的菜单中选择输转名称。

‣ 在 Tankvision Professional 主页上，单击输转工具栏中的一个输转状态，然后在菜
单中单击显示的输转名称。

输转详情屏幕显示单个输转的详情：

 29 输转详情屏幕

9.1  工具栏图标
保存更改

打开/重新打开输转（参见“打开输转”）

暂停输转（参见“暂停输转”）

关闭输转（参见“关闭输转”）

取消输转（参见“取消输转”）

输转日志（参见“输转日志”）
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输转历史记录（参见“输转历史记录”）

输转证书（参见“输转证书”）

历史输转（参见“历史输转”）

放大文本

缩小文本

9.2  输转标题栏
Movement Header 详情显示在输转详情屏幕顶部。

1. 可以通过从 View 菜单中选择 Movement Header 菜单项来隐藏或显示。
2. 输转的 Name、Product 和 Class 可以修改（取决于当前用户的访问权限），其中

包括自定义数据（取决于输转类别）。
3. 如需保存更改，单击工具栏上的 Save Changes 按钮 。

保存更改后，将在审核跟踪中添加一个条目，详细说明所做的更改。

9.3  对象
输转 Subject 详情显示在输转详情屏幕中间的左侧。
对于“Load”或“Receipt”输转类型，其中包含对象名称、从此类别输转中提取的图像、对
象当前状态以及对象的计划数量：

 30 Subject 详情（Load/Receipt）

对于“Transfer”输转类型，其中包含源储罐详情（针对一对多转移）或目标储罐详情
（针对多对一转移）：
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 31 Subject 详情（Transfer）

9.4  储罐输转
输转中涉及的储罐的详细信息（如适用，对象储罐除外）显示在输转详情屏幕中间右侧
的列表中。
如果列表中只有一个储罐，则会以类似对象储罐的形式显示详细信息：

 32 储罐详情

但如果列表中不止一个储罐，则详情会显示在储罐图形旁边，而不是下面：

 33 多储罐
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9.5  最小化组件
为了帮助管理输转或节省屏幕上的空间，可以通过单击组件左上角的 箭头来最小化任
何（或所有）单个组件。

 34 输转屏幕

单击 箭头可以重新打开组件。将鼠标光标悬停在最小化组件上，即可检查此组件的状
态。

 35 最小化组件状态

9.6  定时任务
输转的定时任务详情显示在输转详情屏幕底部的横向列表中：
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 36 定时任务

如果某个输转没有定时任务，则隐藏该列表。
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10  输转日志
输转日志可以从摘要屏幕、输转详情屏幕或历史输转屏幕访问。在其中任一屏幕上，选
择一个或多个属于需要日志的输转的输转组件，然后从 Movements 菜单中选择
Movement Log，或单击工具栏上的 Movement Log 按钮 。
输转日志屏幕显示参与输转的储罐的库存详情：

 37 输转日志屏幕

10.1  工具栏图标
导出（参见“导出”）

打印预览（参见“打印预览”）

打印（参见“打印”）

输转历史记录（参见“输转历史记录”）

输转证书（参见“输转证书”）

放大文本

缩小文本

10.2  输转过滤器
输转过滤器用于指定需要日志的输转。当输转日志屏幕首次打开时，Start Date 和 Stop
Date 字段设置为跨越当天。下拉列表中的输转是指那些创建时间晚于 Start Date，且至
少有一个组件仍未在 Stop Date 前关闭的输转。

‣ 如需修改可用输转列表，请编辑 Start Date 或 Stop Date 然后单击离开字段。

‣ 如需查看输转的日志详细信息，请在下拉列表中选择。
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10.3  数据周期
Data Interval 决定了在日志中显示的数据。当选择一个输转后，Start Date/Time 设置
为输转中第一个组件打开的日期和时间。如果尚未打开任何组件，则将其设置为当前日
期和时间。

‣ 如需修改 Start Date/Time，单击此字段，然后输入日志开始的新日期和时间。然后
单击离开字段。

‣ 类似地，如需修改 Interval，单击字段并输入新周期。可以以分钟为单位，也可以以
冒号分隔的小时和分钟为单位。然后单击离开字段。

10.4  导出
输转日志的当前内容可以通过选择 Movements 菜单中的 Export 或者单击工具栏上的
Export 按钮 导出。
显示以下屏幕，供用户选择导出日志数据的目标文件：

 38 导出输转日志

10.5  打印预览
从菜单 Movements 中选择 Print Preview 或单击工具栏上的 Print Preview 按钮 ，可
以预览输转日志的当前内容报告。
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10.6  打印
从菜单 Movements 中选择 Print 或单击工具栏上的 Print 按钮 ，可以打印输转日志
的当前内容报告。使用工具栏上的 Print 按钮将直接发送报告至默认打印机。如需选择
打印机或修改打印机设置，请从菜单中打印报告。

11  输转历史记录
输转历史记录可以从摘要屏幕、输转详情屏幕或历史输转屏幕访问。在其中任一屏幕
上，选择一个或多个属于需要历史记录的输转的输转组件，然后从 Movements 菜单中
选择 Movement History，或单击工具栏上的 Movement History 按钮 。
输转历史记录屏幕显示更改的详情，此更改指自计划以来已应用于输转的更改：

 39 输转历史记录屏幕

11.1  过滤和排序
对于冗余系统，屏幕顶部会额外显示一个字段，供用户选择存储历史记录的计算机。下
拉菜单包括 Current database server 和每个可能存储历史记录的服务器的名称。

各台服务器上的完整历史记录都有可能不可用，因为这取决于更新时是否可以访问
服务器。

通过 Sort Order 字段，可以按更改日期和时间升序或降序排列历史记录。

11.2  字段
输转历史记录中包含以下字段：
• Date/Time

进行更改的日期和时间。
• Description

对所做更改的描述。
• User

进行更改时登陆的用户的名称（如果有）。
• Computer Name

进行更改时正在使用的计算机的名称。
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12  输转证书
输转证书可以从摘要屏幕、输转详情屏幕或历史输转屏幕访问。在其中任一屏幕上，选
择一个或多个属于需要证书的输转的已关闭输转组件，然后从 Movements 菜单中选择
Movement Certificate，或单击工具栏上的 Movement Certificate 按钮 。

此选项仅适用于关闭的输转组件。

输转证书屏幕显示输转的所有已关闭输转组件的库存详细信息：

 40 输转证书屏幕

如果已设置任何管道，则库存详细信息下方将显示管道相关部分：

 41 管道

12.1  工具栏图标
打印预览（参见“打印预览”）

打印（参见“打印”）
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12.2  输转标题栏
Movement Header 详情显示在输转证书屏幕顶部。输转的 Name、Product 和 Class 可
以修改（取决于当前用户的访问权限），其中包括自定义数据（取决于输转类别）。
单击 OK 按钮时，将保存所做的任何更改。

12.3  库存数据
如需修改任何不正确的库存数据，请单击包含需要修改的数值的字段，然后输入新数
值。然后单击离开字段，或按下 Tab 键移至下一个字段，GSV 值将被更新。
如需修改任何调整数据，请单击包含需要修改的数值的字段，然后输入新数值。
按下 OK 按钮时，将保存所做的任何更改。还将在审计跟踪中写入一个条目，详细说明
所做的更改。

12.4  管道
管道部分允许将设置的管道添加到证书中。一旦添加了管道，就可以更改各种设置，例
如，管道在输转前后是满管还是空管状态。利用管道的容量，可以对输转证书进行调
整，以提供更准确的库存数据。
如需添加管道，请单击管道部分的任意位置，将显示 Add Pipelines 屏幕：

 42 添加管道

单击 Add 添加管道。
从 Pipeline 下拉框中选择需要添加的管道，从 Tank ID 下拉框中选择输转储罐。将在输
转证书上自动计算调整量。

12.5  打印预览
输转证书可以通过单击工具栏上的 Print Preview 按钮 进行预览。

12.6  打印
输转证书可以通过单击工具栏上的 Print 按钮 进行打印。



Tankvision Professional NXA85 历史输转

Endress+Hauser 45

13  历史输转
历史输转屏幕可通过摘要屏幕访问。如需开启历史输转屏幕，从 Movements 菜单中选
择 Historical Movements 条目，或单击工具栏上的 Historical Movements 按钮 。历
史输转屏幕允许访问不再在摘要屏幕上显示的输转。

 43 历史输转屏幕

13.1  工具栏图标
输转日志（参见“输转日志”）

输转历史记录（参见“输转历史记录”）

输转证书（参见“输转证书”）

放大文本

缩小文本
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13.2  过滤器
通过从 View 菜单选择 Show Filter 或单击过滤器标题栏上的箭头，可以显示或隐藏历史
输转的 Filter。
Filter 允许选择需要在历史输转列表中显示的输转的标准。这些标准分为三类：
• Dates

如需按日期过滤输转，必须勾选 By Date Range。然后可以在 Earliest Date 和 Latest
Date 中输入日期。如果从创建输转到关闭最后一个输转组件的日期范围与 Earliest
Date 和 Latest Date 定义的日期范围重叠，则输转将包括在列表中。

• Options
• Show Planned Movements

如果需要显示状态为 Planned 的输转组件，则必须勾选此项。
• Show Open Movements

如果需要显示状态为 Open 或 Reopened 的输转组件，则必须勾选此项。
• Show Closed Movements

如果需要显示状态为 Closed 的输转组件，则必须勾选此项。
• Show Cancelled Movements

如果需要显示状态为 Cancelled 的输转组件，则必须勾选此项。
• Show Subjects

如果需要显示输转对象，则必须勾选此项。
• Show Tanks

如果需要显示输转储罐，则必须勾选此项。
• Show Activities

如果需要显示输转的定时任务，则必须勾选此项。
• Miscellaneous

• Movement Name
允许按输转名称过滤输转。

• Movement Type
允许按输转类型过滤输转。

• Movement Class
允许按输转类别过滤输转。

• Tank ID
允许按储罐（作为对象或储罐参与输转）ID 过滤输转。

如需应用过波器到列表，单击 Search 按钮。

13.3  搜索结果
搜索结果显示在与摘要屏幕上的视图类似的列表中。
如需修改显示的列，从 Options 菜单中选择 Maintain View（ 更多详情参见《输转设
置手册》BA00394G）。
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14  输转工单

14.1  概述
输转工单软件包允许用户根据沙特监管计量标准委员会的要求创建输转工单。
此软件包需要连接到 Tankvision Professional 的工作装置，但在其他情况下属于独立模
块。

14.2  安装
安装文件名为 Movements.Ticketing.Setup.exe。
安装过程中，用户可进行四项设置。

 44 安装选项

ServerName
安装有 Tankvision Professional 的服务器的名称。如果是在同一台实体机上，则可以使
用(local)的默认值。
Database
Tankvision Professional 中存储输转数据的数据库。默认情况下为 Tanks。
UserName
用于连接至 Tankvision Professional 数据库的用户名。缺省设置为 sa 用户。
Password
与上述配置的用户相对应的密码。
安装程序将自动安装任何所需的第三方组件。成功完成安装后，必须重新启动系统。
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14.3  设置
使用输转工单系统前，必须对其进行设置。
在未正确设置模块的情况下尝试创建新工单将导致出错，如下图所示。

 45 设置无效

14.3.1  安全
输转工单模块遵守其所连接的 Tankvision Professional 服务器上的安全设置。

详情参见 Tankvision Professional 配置手册。

14.3.2  设置
使用 Configure 菜单选项访问设置。

 46 设置菜单选项

Settings 菜单选项

 47 Settings

此设置允许用户指定在自动删除输转工单之前，输转工单将在系统中保留的天数。
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Receipt Sources 菜单选项

 48 Receipt Sources

此设置允许用户设置接收源。Receipt Source 的名称长度限制为 8 个字符。

Destinations 菜单选项

 49 Destinations

此设置允许用户设置目的地。Destination Name 的长度限制为 8 个字符。
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Contractors/Hauliers/Suppliers 菜单选项

 50 Contractors, Hauliers and Suppliers

此设置允许用户设置承包商、运输商和供应商。Name 字段的长度限制为 28 个字符。

Tank Seals 菜单选项

 51 Tank Seals

此设置允许用户在 Tankvision Professional 数据库中记录安装在每个储罐上的密封件。
每个储罐有最多 5 个 Seal Identity 编号，编号长度不超过 5 个字符。
更换密封件时，会在内部记录之前的密封件标识和更换日期。

14.4  操作
一旦系统设置正确，就可以创建输转工单。
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14.4.1  创建一个新工单
通过单击 New Ticket 图标（如图），选择 File → New Ticket 或按下 Ctrl-N 创建新输
转工单。

 52 新工单创建

 53 创建一个新工单

当用户选择创建新工单时，将打开一个输转搜索框，以便用户找到需要创建工单的输
转。如果更改 Earliest 和 Latest 时间字段，将用两个日期之间关闭的所有输转填充
Movement 选择框。
用户还可以选择是否为输转的交付部分、输转的接收部分或两者都生成工单。单击 OK
将为所选 Movement 和 Delivery/Receipt 选项创建一个新工单，如图所示。

 54 新工单创建
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现在可以编辑工单详情。
还可以通过双击主窗口中的相关工单来访问工单详情。

14.4.2  编辑工单详情
Movement
已创建工单的输转的名称。
Delivery/Receipt
输转的这一部分将被记录。
Ticket Number
自动为此工单生成索引。
Batch Number
使用可编辑的 9 位批次号。
Location
需要创建工单的 Tankvision Professional 站点。
Location ID
与上面所选站点相对应的 ID。（这取决于在 Tankvision Professional 中为站点设置的
ID。）
Delivery Destination
工单的目的地。用户可以选择系统中设置的任何目的地。
Delivery Order Number
与此工单对应的订货号。
Contractor/Haulier/Supplier
与此工单相关的承包商、运输商或供应商。用户可以选择系统中设置的任何承包商、运
输商或供应商。
Receipt Source
此工单的接收源。用户可以选择系统中设置的任何接收源。
Receipt Order Number
与此工单相关的接收订货号。
Task ID
此工单的任务 ID。
Transaction code
此工单的交易代码。
Product Type
此工单适用的产品类型。用户可以从 Tankvision Professional 中设置的任何产品类型中
进行选择。
用户还可以编辑工单中每个单独包裹的数值。对包裹体积的任何更改都将自动重新计
算。

14.4.3  正式出单
通过在主窗口中选择工单，然后单击 Make Ticket Official 图标（见图）或从菜单中选
择 File → Make Ticket Official，可以使工单正式生效。
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 55 正式出单

只有在 Tankvision Professional 中设置了具有足够的安全权限的用户才能正式出单。如
需正式出单，此用户必须在每次正式出单时输入其登陆信息。

 56 登陆并正式出单

正式出单后工单将无法编辑。
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14.4.4  打印
主屏幕和工单视图都有打印和打印预览选项。任何情况下，用户都必须选择打印的工单
格式。

 57 打印选项

15  术语表
Load 产品从储罐转移至罐区以外的地方。
Receipt 产品从罐区外到达，储存在罐区内的储罐中。
Transfer 产品在罐区的两个或多个储存容器之间输转。
ETF 预计完成时间。
Actual Volume 输转开启后的转移量。
Planned Volume 输转操作中需要转移的量。
Subject 输转对象是将接收或导出全部计划体积的储罐或运输工具。
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16  附录：转移量计算
本章介绍在储罐之间转移产品时用于计算体积的方法，以及使用快速转移和输转向导设
置的输转之间的差异。

16.1  概述
一般情况下，任意 2 个容器之间的转移量计算为一个标准体积。原因是源储罐和目标储
罐的条件可能不相同。例如，如果源储罐中的温度为 10 °C (50 °F)，而目标储罐中的温
度为 20 °C (68 °F)，则由于产品的热膨胀，灌注目标储罐所需的容积要小于灌注源储罐
所需的容积，如下图所示。如果一个储罐中的产品与另一个储罐混合，则不用计算温度
的净变化，而是假设储罐中的条件（温度、压力和密度）在整个输转过程中保持不变。

5000 m³
( bbl)31449.06

T=10 °C 0 °(5 F)
ρ=750 kg/m³ ( lb/!³)46.82

T=20 C 68° ( F)°
=750 kg/mρ ³ (46.82 lb/!³)

5000 m³
( bbl)31449.06

5030 m³
(31637.75 bbl)

4970 m³
( bbl)31260.36
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 58 储罐转移示意图

第二个原则是，输转计算的目的是获取一个目标液位，此目标液位在输转开启后将保持
不变，并且所有报警通知都参考此目标液位。液位计是测量储罐中液位最常用的仪表，
因此，如果试图以某种导出量（无论是容积还是质量）来定义目标，就会导致目标液位
不稳定。以前的输转版本曾尝试过这一做法，但效果不佳。一旦输转开启，就会计算出
输转的目标液位，操作员正是根据这一液位来监控任务的进展。

16.2  使用总计量体积
当将液体混合物从一个储罐输转到另一个储罐时，总计量体积（TOV）可能是最合适的
输转目标类型，因为储罐计量系统提供的库存计算是基于这样的假设，即输转量的成分
是均质的，而不是碳氢化合物和水的乳化液。如下图所示，使用快速转移窗口（参见“储
罐间转移”）只能指定一组储罐作为源储罐和目标储罐。因此，任何混合物都必须全部转
移至另一容器中。
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A B
3

1 2 1 2

3
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 59 简单转移，涉及产品与水的源混合物
A 操作前
B 操作后
1 源储罐
2 目标储罐
3 转移

这与“输转向导”形成了鲜明对比。“输转向导”可能有多个目标储罐，这表示要计划将混
合物中每种成分的多少输转到每个目标储罐过于复杂。如下图所示，水全部被输送到一
个储罐中，而产品则被分送到两个目标储罐。

A B

1 2 1 2
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 60 一对多转移，涉及产品和水的源混合物
A 操作前
B 操作后
1 源储罐
2 目标储罐

因此，在快速转移窗口中使用 TOV 和绝对 TOV 时，目标储罐的目标容积将被确定为当
前目标储罐的 TOV 与需要从源储罐转移的 TOV 量之和。而在输转向导中，储罐输转页
面（参见“储罐页面”）中从源储罐转移的量只包括混合物中的产品成分。如需转移液体
混合物，操作员必须手动输入目标储罐的目标容量。这种情况下，No Control 选项将不
可用。
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16.3  清空与排空
储罐的清空有别于排空，因为需要清除储罐中的所有物质。通常情况下，在储罐停用进
行维护前会进行清空，但在某些罐区，由于其他原因，这种做法也很常见。在许多情况
下，对储罐进行清空时可能需要进行监督确认，即通过输转令储罐低于最低工作液位。
清空操作利用了输转系统使用 TOV 进行规划的能力，其目的是从储罐中移出所有液体，
包括碳氢化合物和水。
排空储罐旨在排出储罐中的所有产品，留下游离水和低于最低工作液位的滞留物。排空
储罐无需监督确认，因为其目标液位是储罐的最小工作液位和游离水位中的较大者。排
空储罐时，应根据罐区的安全操作要求，最大限度从储罐中排出产品。
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